
Gin Rummy Help Contents
Welcome to MeggieSoft Games' Gin Rummy.    Help is organized in the following sections.    Click on the one you
require.    Alternatively, click on the search button above to look for information on a specific subject.

Introduction
How to Play Gin Rummy
Understanding the Interface
Menus
Miscellaneous Information
About MeggieSoft Games

This help system is constructed so that you may cycle through each topic and return to this Contents panel.    
In this way you may easily review all the help information associated with one of the above topics.    Cycling is 
achieved by clicking the links at the top of each panel.    To return here from any topic panel, press the 
Contents button at the top.



 Cycle back to: Contents
Introduction
Gin Rummy adheres to the rules documented in Hoyle's Rules Of Games, and provides common rule 
variations.    Both Oklahoma Gin and Hollywood Scoring are supported.

Ten cards are dealt to each player.    The remaining cards are placed face down by the mat as the stock.    The 
top card is turned face up on the mat to begin the discard pile.

Each player alternately starts their turn by taking either the top card of the stock or the visible card from the 
discard pile.    You continue your turn by knocking (playing melds to the mat), if you have sufficient points to go
out and wish to.    You conclude your turn by discarding one of the cards in your hand, unless you have melded 
an "11 Card Gin" (when permitted).

A round ends when a player has knocked.    The other player may then lay down whatever melds they can, and
add to the knocking player's melds.    They do not take a card (from the stock or discard pile) before this 
action, nor do they discard after.

The difference in melded points is scored for winning a round.    The player who knocks wins the round, unless 
they are "undercut" by their opponent having fewer points of "deadwood" remaining in hand.    Successive 
rounds are dealt and played until one of the players achieves the goal of 100 points to win the game.



 Cycle back to: Contents
How to Play Gin Rummy
After the cards for a round have been dealt, the following is the sequence of each of player's turn, until one of 
the players lays down their melds and knocks:

1 Taking a card from the stock or the discard pile
2 Melding cards from your hand to the mat,    if you are able to go out
3 Discarding one of the cards from those in your hand.
If the stock is reduced to two cards before either player lays down their melds, the cards are shuffled and the 
round is redealt.

Select a topic:

The Deal
Taking From The Stock
Taking From The Discard Pile
Melding Cards To The Mat
Discarding
Scoring
Getting Started
Watching a Game Being Played
Hollywood and Series Scoring
Oklahoma Gin



 Next panel: Taking from the Stock
The Deal
The first round is dealt automatically after you confirm that you will start the first round, or after the cut for 
deal (if this option is selected).

After the end of each round, Gin Rummy will shuffle and deal the cards for the next round. 

At the end of each game, you will be asked if you want to proceed with the next game.    If you select "Yes", Gin
Rummy will shuffle and deal the cards.

At any time, you may select "Redeal Game" from the Game menu.    In this case, the current game is 
abandoned, and the cards are reshuffled and redealt.    Alternatively, you can select "Restart Round", in which 
case the cards are not shuffled and the current round is restarted.

If "AutoMouse Cards" is enabled, the mouse pointer will    be moved automatically to the deck after the cards 
have been dealt.



 Next panel: Taking from the Discard Pile
Taking From The Stock
You start you turn by taking the top card from the stock or the visible card from the discard pile.

To take a card from the stock, position the mouse pointer over the face down card on top of the stock. (In 
AutoMouse mode, the mouse will have been automatically positioned over the stock after you discarded the 
previous card.)    Click down with either the left mouse button on the card.

The card will then be displayed face up for you to see it.    If you now release the mouse button, the stock card 
will be removed from the stock and added to your hand,    which will immediately be sorted.    Or you may drag 
the stock card directly to the discard pile, a meld, or your hand.

Note that if you are starting a round and attempt to take from the stock (because you did not want the 
discard) the opponent has the right to interrupt and assume the lead if it wants the discard.    Similarly, the 
opponent will offer you the option to take the discard and the lead, if it is starting the round and does not want
the first discard.



 Next panel: Melding Cards To The Mat
Taking From The Discard Pile
If you wish to take the visible card from the discard pile, you may do this instead of taking a new card from the
stock.

To take the discards, position the mouse pointer over the card and click the left mouse button.    Alternatively, 
you may drag the card from the discard pile and drop it over your hand.



 Next panel: Discarding
Melding Cards To The Mat
You will meld cards either when you have chosen to "knock", or when laying off your cards after the opponent 
has knocked.

You may either create a new meld of at least three cards, or you may add one or more cards to an existing 
meld displayed on the mat.    You may add to any displayed meld, whether it originated from your hand or the 
opponent's.    Similarly, your opponent may add cards to melds you put down when you have knocked.

You then continue melding until you discard (if you knocked), or have laid off all your possible cards (if the 
opponent knocked)- in which case you click on the mat to signify that you have finished.

You meld a card by clicking on it (it will then be highlighted, click on it again if you wish to deselect it), and 
then clicking on the meld area.    Or you may drag the card directly to the meld area.    To create a new meld, 
place the card on an exposed part of the mat.    To add to an existing meld, place the card on top of the meld.

Multiple cards may be melded in a group (select each first), or singly.    If you meld singly, you must complete 
the meld before starting another or discarding.    Use the "Undo" feature if you make an error.



 Next panel: Scoring
Discarding
You end your turn by discarding any one of the cards in your hand.    The only exception being that if the "11 
Card Gins" rule preference is selected and    you can meld all the cards in your hand you may do so.

To discard a card, position the mouse pointer over the card and click the RIGHT mouse button.      Alternatively, 
you may click the LEFT mouse button with the ALT key depressed.    Alternatively, you may drag and drop a 
card directly from your hand to the discard pile.

If you have selected "Discard Protect" under the "Player" tab of the "Preferences" menu option, a confirming 
popup menu will appear when you click on the right mouse button.

Note that you cannot discard while cards are highlighted.    You must deselect any highlighted cards before 
discarding.    If you started your turn by taking cards from the discard pile, the card which was automatically 
highlighted must be melded and cannot be deselected.



 Next panel: Getting Started
Scoring
Points are scored as the difference between the deadwood (i.e., not melded to the table) held by each player 
at the end of each round.

The points values are:            
1 Point : an ACE
Face Value : a TWO through NINE
10 Points : a TEN, JACK, QUEEN or KING

 If a player knocks with a Gin (no deadwood remaining) they are the winner.    Otherwise, if the other player 
undercuts the knocker with the same or less deadwood points, that player wins the round.    Otherwise, the 
player with the least deadwood is the winner.    25 bonus points are awarded to a player scoring a Gin.    25 
bonus points are awarded to a person scoring an undercut.    If a player lays down all their cards on an 
opponent's non-Gin knock, the undercut is termed a Gin Off.

Successive rounds are played until one of the players wins the game with 100 points.    At the end of the game 
the points for each round for each player are totaled.    A 100 point game bonus is awarded to the player with 
the higher total. If the losing player failed to win any rounds, a shutout bonus equal to the points total plus the 
game bonus is awarded to the winning player.    Box bonuses of 25 points per round or extra box won are also 
awarded to each player.



 Next panel: Watching a Game Being Played
Getting Started
When you first start Gin Rummy, you will see a "Start" button in the status bar.    If you wish to make any menu
option changes before starting, now is a good time to do this.    Then click on the start button.

The first round of the first game starts with your turn, which you make by either taking a new card from the 
stock, or by taking the card from the discard pile.    The lead on each successive round goes to the loser of the 
previous round.

If you elect to take a new card from the stock, you click down on the top of the stock.    The top card will then 
be turned face up for you to see, and, when you release the mouse button, will be automatically added to your
hand.    Alternatively, if you want to take the card from the discard pile, click on it.

If you are able to meld your cards and knock, and wish to, you may do so at this time.

End your turn by discarding a card from your hand by clicking on it with the RIGHT mouse button. 
Your opponent (the computer) will then play its turn, and so on.

At any time you can get assistance on what to do next by clicking on the leftmost button in the status bar.



 Next panel: Hollywood and Series Scoring
Watching A Game Being Played

If this is your first experience of Gin Rummy, you might prefer to watch a game being played before launching 
into reading the help information in detail.

Follow the following steps to set Gin Rummy into AutoPlayer mode.

1 Select "AutoPlayer" from the "Assistant" menu
2 Select a skill level for the player.    "Expert" would be a good choice.    Press "OK"
3 Sit back and watch.
4 Press the "Stop AutoPlay" button on the status bar when you have watched for long enough.



 Next panel: Oklahoma Gin
Hollywood and Series Scoring
Hollywood Scoring
Under Hollywood scoring, three games (or sub-games) are played simultaneously and three corresponding 
columns of scores are maintained .    The first score for a player in sub-game 1 is entered in the first column, 
their second score is entered in columns one and two, and their third and subsequent scores in the first sub-
game are recorded in all three columns.

When the first sub-game ends (when one of the players has reached 100 points), its column is tallied and play 
continues in the second sub-game.    During the second sub-game, each player's scores will    be recorded in 
both the second and third columns.    However, if a player didn't score anything in column one, their first score 
in column two is not repeated in column three.

At the end of the series of three sub-games, the columns for each player are totaled and the player with the 
higher total scores the difference in totals as the score for that game.

Series Scoring
Series scoring is similar to Hollywood scoring except that scores are only tallied in the current column.



 Cycle back to: How to Play Gin Rummy
Oklahoma Gin
Oklahoma Gin is a common variation of Gin Rummy, the differences from the default game being:

· The minimum points required to knock is defined by the card dealt to the discard pile at the beginning of 
the round.    Therefore if, say, the first discard is the Five of Diamonds, then no more than five points may 
remain in your hand as deadwood in order for you to successfully knock.    By normal convention, if an Ace
is the card dealt to the discard pile, then a Gin is required (rather than a minimum of one deadwood point)

· If the first card dealt to the discard pile is a Spade, then the points won at the end of the round will be 
doubled.    The number of extra bonus boxes earned (if the "extra boxes" points option is selected) will also
be doubled.

Two variations to the rules are available under the Preferences option of the Edit menu:

· The minimum knock requirement for an Ace is one point, instead of a Gin.
· The doubling of points and extra bonus boxes when a Spade is dealt may be deselected.



 Cycle back to: Contents
Understanding the Interface
The stock is shown face down to the left of the mat, with the discard pile arranged face up on the mat, to the 
right of the stock.    The opponent's cards are displayed face down above the mat, and the player's cards are 
displayed face up below the mat.    Melds are displayed on the mat, below the discard pile.

The scoresheet is displayed to the right of the mat.    Rule options and points values are shown to the left of 
the mat, under the stock.    The status bar along the bottom of the window displays information about the 
game in progress as well as providing shortcut buttons to facilitate hand adjustments and obtaining hints.

Select a topic:

Using the Mouse
Drag and Drop
Point and Click
Arranging Your Cards
The Scoresheet
Status Bar Counters
Shortcut Buttons
Visual and Sound Effects



 Next panel: Drag and Drop
Using The Mouse
Gin Rummy supports both "Drag and Drop" and "Point and Click" mouse operations.    Point and Click 
operations are performed by single clicking.    Double-clicking is not supported.

For both methods of mouse operation, actions take effect when the mouse button is released, and are ignored 
if the mouse button is released in a different area from where it was depressed when the "No Drop" cursor is 
showing.    The only exception is when taking a new card from the stock when the card will move to the 
player's hand if the mouse button is released under the "No Drop" cursor.

The left mouse button must be used for all game operations except that of discarding from your hand.    

The right mouse button is normally used to discard from your hand, although you may use the "Alt" key with 
the left button if you prefer.    Right-clicking will display a convenient PopUp of common menu options. If 
"Discard Protect" is selected, the PopUp menu displayed over the player's hand will include discard 
confirmation as the first option.

The AutoMouse features may be enabled to move the mouse automatically between the stock and the player 
area and/or to and from the message and information windows.



 Next panel: Point and Click
Drag and Drop
"Drag and Drop" mouse operations are performed by clicking down on the mouse button above the card to be 
moved, dragging the mouse pointer to the destination, and then releasing the mouse button.    Unless 
suppressed, the card will be dragged with the mousepointer - in which case the top left corner of the card is 
considered to denote the pointer coordinates instead of the mousepointer itself.

The valid moves are:

· Stock card to: player's hand, discard pile, meld
· Discard pile to: player's hand, meld
· Player's hand to: discard pile, meld, another part of player's hand

Cards may be melded from the player's hand singly or as a group.    To move as a group, select the    cards 
using the point-and-click method and then drag one of the cards in the group to the meld destination.    You 
may meld cards to an existing meld or form a new meld.    To form a new meld, drag to an uncovered part of 
the mat.



 Next panel: Arranging Your Cards
Point and Click
"Point and Click" mouse operations are performed by clicking down and releasing the mouse button on the 
card to be moved and then clicking down and releasing the mouse button on the destination.

The valid moves are:

· Stock card to: player's hand or discard pile
· Discard pile to: player's hand
· Player's hand to: discard pile (right-click) or meld

Cards may be melded from the player's hand singly or as a group.    To move as a group, select each of the 
cards and then click on the meld destination.    You may meld cards to an existing meld or form a new meld.    
To form a new meld, click on an uncovered part of the mat.

Note that the stock card is displayed as soon as you click down on it.    When the button is released it will move
to the player's hand.    Discarding is immediate upon a right click, unless "Discard Protect" is selected from the 
"Player" preferences tab.



 Next panel: The Scoresheet
Arranging Your Cards
By default, Gin Rummy automatically sorts and resorts the player's cards when dealt, and when new cards are 
added to it.    The default sortation is suit within rank.    When the "Sort By Suit" option is selected from the 
"Player" menu, the sortation is changed to be rank within suit.    All sorting is performed in the order: Clubs, 
Diamonds, Spades, Hearts.    This improves color differentiation of adjacently displayed suits.

You may chose to arrange the cards yourself by selecting the "No Sorting" option from the "Player" preferences
tab.    In this case,    new cards are always added to the right of the hand.      You may Drag and Drop cards to 
the left and right within your hand to order them to your liking.

You may also establish a "reserved" set of cards which remains part of your hand, but is maintained separately
to the right side of the main hand.    The reserved set is never sorted. To start a reserved set, drag a card past 
the right side of the hand, and drop it.    You may move cards between the reserved set and your hand at any 
time.    Cards can be selected, melded and discarded from the reserve just as they can from the main hand.

Remember that if you click on the left mouse button and release the button without moving the card, the card 
will be selected for melding.



 Next panel: Status Bar Counters
The Scoresheet
The information on the scoresheet to the right of the mat is displayed as follows:

· The scores for each completed round are added the scoresheet at the end of the round.
· If extra boxes are awarded, one dash for each will be displayed under the round score.
· Running totals are displayed in italics.    The running totals of points melded in the current round are 

displayed at the bottom of the scoresheet.    After the second round of a game is completed, the running 
points totals for the current game are displayed under the round scores.

· Game bonus scores are added at the end of the game, or at the end of each sub-game (or column) for 
Hollywood Scoring and Series Scoring.

· If the scoresheet is about to become full, earlier round scores will be consolidated into a single line, 
displayed in bold font.

Because the scoresheet is facing the player, it is maintained from the player's perspective - hence the player 
is "Me" and the opponent is "You".

Select the "View - Round Scores" menu option to see the full details (including date and skill level) of all rounds
of the current game.



 Next panel: Shortcut Buttons
Status Bar Counters
The following counters are displayed in the status bar:

· Stock:    The number of card remaining in the stock.
· Player (optional):    The number of prior games won by the player.
· Opponent (optional):    The opponent skill level and the number of prior games won by the opponent.
· Round: The current round number within the current game.
· Turn: The turn number within the current round.
· Knock: The maximum deadwood that you are permitted in order to knock
· Hand:    The total points value of the cards in your hand.
· Dead (optional): The current deadwood points total in your hand.



 Next panel: Visual and Sound Effects
Shortcut Buttons
You may click on the parts of the status bar described below in order to achieve the associated actions.

· Error Messages:    Click on an error message to clear it.
· Query Symbol:    Click to get assistance on what you can do at this point of your turn.
· Light Bulb:    Click to get a hint.
· Undo:    Click to undo your current turn and start over.    Note that you cannot undo taking a new card from 

the stock.
· Card Alignment:    Click to switch between normal and staggered display of the player's hand.
· Sort Order:    Left-click on the sort order symbol to switch between rank sortation and suit sortation of the 

cards in the player's and opponent's hands. Right-click on the sort symbol to inhibit automatic sorting of 
the player's cards.    The symbol will then be dimmed with an "X" over it.    Right-click again to re-enable 
automatic sorting.

Where a shortcut button is associated with a Preference setting, the change is not saved.    You must change 
the setting via the "Edit - Preferences" menu option if you wish a change to be saved permanently.



 Cycle back to: Understanding the Interface
Visual and Sound Effects
Gin Rummy provides a number of visual effects and sound effects to improve realism and enhance your 
playing pleasure.    These are:

· Rounded card corners
· Customizable color schemes
· "Wallpaper" effects for the main table window and the mat
· Animation and visual card dragging
· Custom card-style mousepointers
· MIDI music support
· Sound effects
· Synthesized speech output
The above may be selected, customized, and deselected via the "Preferences" option under the "Edit" menu.

Note that these effects make intensive use of processor and graphics resources and can reduce 
responsiveness on slower or less graphics-capable systems.    If you find Gin Rummy's interface to be sluggish, 
you should experiment with disabling some of the visual and sound effects.



 Cycle back to: Contents
Menus
The following drop-down menus are available:

Game Menu
Edit Menu
View Menu
Assist Menu
Help Menu



 Next panel: Edit Menu
Game Menu
The following selections are available under the Game Menu:

AutoPlayer
Change Players
Restart Round
Redeal Game
Reset Scoreboard
Save Scoreboard
Exit



 Next panel: View Menu
Edit Menu
The following selections are available under the Edit Menu:

Undo
Swap Cards
Music Playing
Preferences



 Next panel: Assist Menu
View Menu
The following selections are available under the View Menu:

Round Scores
Game Scores
League Table
Hall Of Fame
Toggle Rules/Points



 Next panel: Help Menu
Assist Menu
The following selections are available under the Assist Menu:

Explain
Suggest
Recall
Distribution



 Cycle back to: Menus
Help Menu
The following selections are available under the Help Menu:

· Help On Help: Displays help regarding the    use of the Microsoft Windows Help system.
· Main Contents:    Displays the main Gin Rummy help window.
· Search Topics:    Displays the Gin Rummy topics search window.
· Order Form: Displays a form for you to enter your name and address and print the order form to register 

Gin Rummy.
· Enter Registration:    Permits you to enter or re-enter your registration number.    Should the Gin Rummy    

options data on your hard disk become missing, Gin Rummy will return to the unregistered status.    In this 
case, you will need to re-enter your registration details.

· ReadMe File (MeggieSoft Games): Displays the README.TXT file using the associated txt file program for 
your system.

· ReadMe File (Gin Rummy): Displays the READGIN.TXT file using the associated txt file program for your 
system.

· MeggieSoft Home Page: Accesses the MeggieSoft Games home page (Provided you have Internet 
capability and an associated web browser)

· About:    Displays information about the version number and author, and the registration confirmation.



 Next panel: Suggest
Explain
When selected, the "Assist!" window will appear.    

The Assist! window is context sensitive and will describe your alternatives at the current state of play.

You may move the Assist! window by dragging its title bar.



 Next panel: Recall
Suggest
When selected, Gin Rummy will examine your hand and display a reasonable series of actions for you to take.   
(Gin Rummy does not take advantage of this knowledge when determining subsequent turns for the 
opponent.)

When it is your turn to take a card, the display is a suggestion as to whether you should take a card from the 
stock or from the discard pile.    If the suggestion is to take a new card from the stock, that will be the entire 
suggestion.    (If you elect to "Do It", then the remaining suggestions will be given after the new card has been 
taken into account.)

You may select the "Do It" button when the suggestion box is displayed, and Gin Rummy will play the 
suggestion(s) for you.    If you select "Do It" and the first suggestion is to take a new card from the stock, then 
another suggestion box will be displayed after the new has been added to your hand.

Gin Rummy employs the same logic for providing the suggestion as it does for playing the opponent's hand.    
The method employed is the "Expert" skill level.



 Next panel: Distribution
Recall

The Recall facility is a powerful aid to those who cannot remember which cards have been seen during play.    It
is not intended to be used frequently as an alternative to concentration, but may help you develop improved 
powers of recall.

When this menu entry is selected, you will be asked if you wish to recall "Seen", "Unseen", or "Both".

"Seen" cards are listed in two parts: those in your hand that the opponent has seen you take from the discard 
pile, and those that you have seen the opponent take.

"Unseen" cards are all those cards which are: not in your hand, not in the discard pile, not melded, and not 
among those of the oppnent's cards that you have seen.    They are therefore the content of the stock and the 
unseen portion of the opponent's hand - but who knows which is where?



 Cycle back to: View Menu
Distribution
Select this option to see a map of all the cards and their current locations (discard pile, seen taken to 
opponent hand, etc.)    The display does not identify the location of cards that the player has not seen which 
are in the stock or in the opponent's hand.



 Next panel: Game Scores
Round Scores
Displays the winner, and the scores of the player and the opponent, for all previous rounds of the current 
game.

The display includes the date and opponent skill level for each game.    If the player's scoreboard was started 
with an earlier version of Gin Rummy which did not record dates and skill levels, the scoreboard will be 
automatically converted to the new format.    For these records, the opponent will be displayed as "Unknown" 
and the date will be displayed as "1/1/94".

The text colors (blue for wins, red for losses) may be changed via the "Edit - Preferences" menu option.



 Next panel: League Table
Game Scores
Displays the winner, and the scores of the player and the opponent, for all previous games played by the 
currently active player. 

The display includes the date and opponent skill level for each game.    If the player's scoreboard was started 
with an earlier version of Gin Rummy which did not record dates and skill levels, the scoreboard will be 
automatically converted to the new format.    For these records, the opponent will be displayed as "Unknown" 
and the date will be displayed as "1/1/94".

A selection pad permits the display of the game history against the opponent at a particular skill level.

The text colors (blue for wins, red for losses) may be changed via the "Colors" tab of the "Edit - Preferences" 
menu option.



 Next panel: Hall Of Fame
League Table
When selected, Gin Rummy will display the following information for all players for whom a saved scoreboard 
file exists: Games Won, Games Lost, Points For, Points Against, Average (points for divided by games played)



 Next panel: Toggle Rules/Points
Hall Of Fame
When selected, Gin Rummy will examine all saved scoreboards and display statistics such as highest and 
lowest scores for and against, narrowest and widest winning margins, etc.



 Cycle back to: View Menu
Toggle Rules/Points
Selecting this menu option will toggle between the rules display and the points display.

You may also click on the Rules/Points panel itself to achieve the same action.



 Next panel: Swap Cards
Undo
Select this option to undo your current turn and start it again.

This option is only enabled during your turn.      You cannot undo the opponent's turn, nor your previous turns.    
You cannot return a seen card to the stock.    Once you have discarded, you cannot turn back.    Thus, the undo 
feature only permits what a reasonable human opponent would permit.

If you started your turn by taking a new card from the stock, that card will not be returned to the stock 
(because you have already seen it).    You will restart your turn from immediately after you took the card.

If you started your turn by taking from the discard pile, that card will be returned to the discard pile and you 
will restart your turn by taking a new card from the stock or from the discard pile.

If you have highlighted cards in your hand, the undo option will deselect them - even if there is nothing else to 
undo.



 Next panel: Music Playing
Swap Cards
Select this menu option if you wish to swap cards with the Opponent.    Gin Rummy will then swap the cards 
currently in the player's hand with those in the opponent's hand.

The purpose of the option is as a learning tool.    It is not intended to be used to distort your true scoring ability
relative to your peers, as might be reported by the League Table and the Hall Of Fame.



 Next panel: Preferences
Music Playing
Select this menu option to see what MIDI music track is currently playing.    You may then choose to skip or 
stop the current music track if you wish to.



 Cycle back to: Edit Menu
Preferences
You may customize Gin Rummy to your taste by selecting Preferences from the Edit menu. The preference 
options are changed under the following tabbed panels.    If you want your changes saved for future sessions, 
ensure that the "Save Properties" box is checked.    Preferences are saved separately for each player.

Screen
Colors
Cards
Card Back
Dealing
Animation
Sound
Music
Speech
Automatic
Messages
Player
Opponent
Rules
Points



 Next panel: Colors
Screen
The following preferences are available:

· Main Window Size:    Depending upon your monitor resolution setting, up to five window sizes are 
available, the fifth of which is "Custom".    As an alternative to selecting a standard window size via 
preferences, you may also resize the main window by dragging the lower left corner.    The resulting size is
held as the Custom setting so that you can return to it later.

· Table Effect: Select if you want the main table window to be "wallpapered" with a bitmap file (bmp or wmf)
of your choosing.

· Mat Effect: Select if you want the mat to be "wallpapered" with a bitmap file (bmp or wmf) of your 
choosing.

· Suppress 3D Effect: Select if you wish to disable the 3D effects in the main window.
· Hide Rules/Bonuses: Select if you wish the rules/bonuses panel to not be displayed.
· Game Score Display: Select "Title Bar" or "Status Bar" to display game scores elsewhere than the default 

of in the main window.



 Next panel: Cards
Colors
The color preferences are used to provide on-screen adjustment of the colors displayed by Gin Rummy.

First, in the upper part of the window, select the target area for which you want to change the color.    The 
current color is displayed below the "Target" selection frame.    If the target allows you to change both the text 
and the background colors, select the one desired.

Second, click on the "New Color" button to select the color to which you require to change the target.    The 
standard Windows color selection window will be displayed.    You will return to the color control window after 
you have made your new selection.

If you wish to preview the effect of the change, click the "Preview" button.    The revised color scheme will be 
dynamically displayed "on-screen" in the main Gin Rummy window.    If you cancel the preferences window 
after previewing, the previous color scheme will be reinstated.

The "Reset" selection frame allows you to set all colors to how they were before you selected "Preferences", or 
to the Gin Rummy default color scheme.



 Next panel: Card Back
Cards
Provided that the required image files exist in the same directory as Gin Rummy and your available video 
memory resources permit, you may select any of four card display sizes.    Note that the font size displayed in 
Gin Rummy's main window, and the size of the status bar and speed buttons, are adjusted to correspond with 
the card sizes larger than the regular size.

Alternatively, you may select either of the following:

· Do Not Automatically Resize: The card size will always be as specified, unless the window size is too small 
to accomodate the selection - in which case it will be automatically reduced.

· Resize Per Window Size: Card size varies automatically with corresponding window size.    (Custom window
sizes will select the nearest appropriate size).

· Resize To Largest Possible: Card size varies one size larger than the corresponding window size.    (Custom 
window sizes will select the nearest appropriate size.)

Select "True Corners" for a more realistic card appearance with rounded instead of square corners. This may 
result in a performance penalty when cards are displayed.



 Next panel: Dealing
Card Back
There are six standard card back designs available, plus you may use bitmap image file (bmp or wmf) of your 
own design or choosing. Click on the Standard or Custom button to select the range required.    Use the drop-
down list for standard cards or Browse to select a custom card design.

Gin Rummy does not provide graphic design capabilities, so it is assumed that you are able to scan, copy, or 
design any custom image file(s) you require using other tools.    You may also use other appropriately sized 
bitmap files on your system.

The size of the "regular" card image is 71 by 96 pixels.    If the image is larger, Gin Rummy will take the card 
back from the upper left part of the design.    Gin Rummy will automatically resize the card back design when 
card sizes other than "regular" are selected.

You do not need to add the card frame (single pixel black line around the edge) or trim the corners.    Gin 
Rummy will do this automatically when it loads the card back image file, which will override your efforts 
anyway.



 Next panel: Animation
Dealing
The following preferences are available:

· Cut For Deal: When selected, each game will start with a cut for deal.    Otherwise, the player leads to the 
first and odd numbered games while the opponent leads to even numbered games.

· Quick Deal: When selected, cards are dealt as a block instead of individually.    This speeds up the display 
at the start of the game, at the expense of realism.

· Quiet Deal: When selected, cards are dealt individually but the Place Card sound effect is inhibited during 
the deal.    This speeds up the display.



 Next panel: Sound
Animation
The following preferences are available:

· Suppress Card Animation: When selected, a card being moved automatically will disappear from the 
source and reappear at the destination, instead of floating from the source to the destination.

· Suppress Animated Card Twisting: When selected, cards do not twist when floating, but are moved flat.
· Constant Travel Time: When selected, the duration of each animated card movement is the same.    

Otherwise, the duration is distance dependent (i.e., cards move at a constant speed).
· Animation Speed: Select the flight time duration for when cards are moved automatically from source to 

destination.
· Suppress Card Display When Dragging: When selected, a dragged card will not be displayed in motion 

under the mousepointer.
· Use Standard MousePointers: When selected, the standard Windows mousepointers are used instead of 

the special card-style mousepointers used by Gin Rummy .
Note that the 32-bit version of Gin Rummy is unable to attractively support card display and special 
mousepointers when dragging cards.    This is a limitation of the Microsoft 32-bit operating environment. The 
32-bit version therefore requires that one of the latter two options is selected.



 Next panel: Music
Sound
This preference panel permits you to enable and disable sound effects, and to specify the sound effect files to 
be used.    Gin Rummy permits the optional association of a wav file with each of the    nine events shown.

If you do not have a sound card, the speak.exe driver is a freely available Microsoft product which uses your 
PC speaker to play (low quality) sound.

If your system has difficulty playing music and other sounds simultaneously, either do not enable the music 
feature, or do not enable sound and speech features.

To change a sound effect, select the corresponding button.    The name of the currently assigned file name will 
be displayed.    (If there is no associated sound file, [none] will be displayed.)    To test the sound, press "Test".    
To assign or change a sound file, press "Browse..." and select the required sound file.    To break the association
between the file and the event, press "Clear".

Select "No Sound Synchronization" to prevent Gin Rummy waiting for silence between issuing sounds and/or 
processing certain actions.    When selected, processing will be faster, but sounds may cut each other off and 
not synchronize well with actions.    You should select this option only if your system is one that freezes as a 
result of Gin Rummy's sound effects or speech processing.



 Next panel: Speech
Music
This preference panel permits you to enable and disable the playing of MIDI music files and to specify the 
music file(s) to be played.

If your system has difficulty playing music and other sounds simultaneously, either do not enable the music 
feature, or do not enable sound and speech features.

When music is playing, you may also select the "Music Playing" option (Edit menu) to display the name of the 
file being played, to skip to the next MIDI file in the filefolder, or stop the music.

To change the music file from that displayed, press "Browse..." and select the required MIDI music file.    (If 
there is no currently associated file, [none] will be displayed.)    To test the music, press "Test".    To clear the 
music file selection, press "Clear".

The available play modes are:

Single - the selected music file will be played once.
Repeat - the selected music file will be played repeatedly
Cycle - the music files in the filefolder will be played in sequence.
Random - the music files in the filefolder will be played in random order.



 Next panel: Automatic
Speech
When enabled, Gin Rummy will speak to you.    The spoken phrases will include prompts, error messages, 
confirmations, and score summaries.    The facility will work with your PC's internal speaker (provided you have
Microsoft's speak.exe driver installed), but the quality is much better with a sound card.

The dictionary file contains pronunciation rules for non-standard words.    If you wish to edit it you will need to 
use the dictionary editor provided with the diskette version of Gin Rummy.

The voice font file defines the voice to be used.    The default voice font is distributed with Gin Rummy.    
Alternative voice files may be available for download from PC WholeWare's web site.        There is a link to this 
site from the MeggieSoft Games web site (see "About" under the Help menu for the URL).

You may set the pitch, tempo, and volume of the voice to your liking.    Note that the "Test" Button is only 
operative when the Speak-ToMe feature is enabled.

MeggieSoft Games has licensed the WinSpeech technology from PC Wholeware for inclusion with Gin Rummy.   
If the Speech System is not included with your installation, you may download a copy from the MeggieSoft 
Games web site or register for the diskette version.



 Next panel: Messages
Automatic
The following preferences are available:

· AutoStart: When selected, the "Start" button will not appear in the status bar at the start of a player's 
session.    Note that preference changes before the start of a session may only be made when this button 
is displayed.

· AutoResume:    When selected and multiple players are defined, Gin Rummy will remember which player 
was playing when it exits, and will automatically start up for that player when Gin Rummy is next run.

· AutoMouse - Cards: When selected, the mouse pointer automatically moves: (i) to your hand when you 
take a new card from the stock or you take one or more cards from the discard pile, and (ii) back to the 
stock after you discard.

· AutoMouse - Dialogs: When selected, the mouse pointer automatically moves to any message or 
information windows which are displayed and, if "AutoMouse - Cards" is also selected, back to the player's
hand or the stock after the dialog window is dismissed.    Some mouse drivers and add-in utilities also 
perform this function. Therefore this is a separately selectable option within Gin Rummy.

The AutoMouse facilities are intended to reduce potential carpal tunnel strain for avid players of Gin Rummy.



 Next panel: Player
Messages
The following preferences are available:

· Display Error Box:    When selected, error messages displayed by Gin Rummy are shown as dialog boxes 
(with an "OK" button) instead of in the status bar.

· Suppress Tool Tips: When selected, Tool Tips are not displayed when the mouse is positioned over one of 
the speed buttons in the status bar.

· Suppress Status Messages: When selected, status messages are not displayed in the status bar during 
play.    Error messages will continue to be displayed as appropriate.    Note that opting to have game scores
displayed in the status bar automatically supresses status messages.

· No Start Reminders:    When selected, the reminder of who starts the next round or game is suppressed.
· No Bell:    When selected, the bell/beep sound associated with errors is suppressed.    It is recommended 

that the "Display Error Box" option be selected in this situation so that error messages don't go unnoticed.



 Next panel: Opponent
Player
The following preferences are available:

· Discard Protect:    When selected, the discard action requires confirmation from the resulting PopUp menu.
· Meldable Card Warning:    When selected, confirmation will be requested if the player is about to discard a 

card which could be melded.
· Do Not Sort:    When selected, the player's hand is not automatically sorted as cards are added to it.
· Sort By Suit:    When selected, the sort criterion is set such that cards will be sorted by rank within suit.
· Display Deadwood Counter: Adds a counter to the status bar which tracks the amount of deadwood in 

your hand.
· Stagger Hand:    When selected, the cards in the player's hand will be displayed such that the suits are 

vertically offset from each other.
· Missed Layoff Warning: When selected, confirmation will be requested if you have missed a layoff 

opportunity when the round ends.



 Next panel: Rules
Opponent
The following preferences are available:

· Skill Level:    Select the skill level required from the six ascending skill levels listed in the drop-down box.
· Quick Display:    When selected, Gin Rummy does not enact the 400 millisecond pause between each of 

the opponent's actions.
· Suppress Discard Highlighting:    When selected, the highlighting of cards taken from the discard pile 

during the opponent's turn will be suppressed.
· Suppress Stock Highlighting:    When selected, the highlighting of a card taken from the stock by the 

opponent will be suppressed.
· Show Cards:    When selected, shows the opponent's cards face up.
· Show Final Discard:    When selected, the opponent's final discard will be displayed face up.    (Standard 

rules do not require the opponent to show their final discard.
The Show Cards option is accompanied by an additional option which enacts the action only at the end of a 
round.    The use of the Show Cards option without selecting this additional option permits you to test for 
yourself the assertion that, when unobserved, the majority of people will cheat!



 Next panel: Points
Rules
The following preferences are available:

· No Lead Exchange:    The exchange of lead is not offered when the first player declines to take the discard.
· Ace Can Meld High:    Aces may    be melded as part of a Q-K-A run or as part of an A-2-3 run.
· Rank Melds Only:    Only melds of the same rank may be played.
· Run Melds Only:    Only melds that are runs may be played.
· Hollywood Scoring:    A game is comprised of three sub-games with scores recorded in columns per the 

rules for the Hollywood game.
· Series Scoring:    Similar to Hollywood Scoring, but scores are not repeated across columns.
· Oklohoma Gin: The knocking level depends upon the first upcard.
· Double Gin:    A player may lay down all their cards as a Gin, without having to discard, and score two gin 

bonuses.
· Ellwood Gin:    A Gin comprised of cards of a single suit scores a gin bonus of 70 points. (Dedicated to the 

inhabitants of Elwood, Pennsylvania.)
· Must Gin:    A player may only go out by laying down a Gin
· Layoff On Gin:    A player may layoff cards on the other's Gin.



 Cycle back to: Edit Menu
Points
The following preferences are available:

· Gin Bonus:    Default is 25 points, adjustable from 0 to 50.
· Undercut Bonus: Default is 25 points, adjustable from 0 to 50.
· Gin Off Bonus (for undercutting with a "gin"): Default is 25 points, adjustable from 0 to 50.
· Game Score (points required to win game): Default is 100 points, adjustable from 100 to 500.
· Game Bonus (for winning a game): Default is 100 points, adjustable from 0 to 200.
· Box Bonus (for each round won): Default is 25 points, adjustable from 0 to 50.
· Scoring of one extra box for an undercut and two for a Gin.    Optionally a Gin Off undercut may score 

three extra boxes instead of one.
· Inclusion of box bonuses in the shutout bonus calculation when the other player fails to score any points 

during a game.
· Interpretation of Ace in Oklohoma Gin - whether zero points or one point of deadwood is required to 

knock.
· Doubling of points (and extra box awards) earned in Oklohoma Gin when a Spade is dealt as the first card 

of the discard pile.



 Next panel: Change Players
AutoPlayer
AutoPlayer puts Gin Rummy into a fully automatic mode whereby both the opponent's and the player's hands 
are played alternately by the computer.    AutoPlayer is a valuable learning facility for new users who wish to 
watch the game being played before playing it themselves.

When the AutoPlayer option is selected, you may be asked if the updated scoreboard for the current player is 
to be saved.    Respond "yes" if you wish to recover to the current state after AutoPlayer has finished, 
otherwise recovery will be to the point that the scoreboard for the current player was last saved.

You will be asked to define which of the six skill levels is to be used by the player. The opponent will play at the
skill level in operation when AutoPlayer is selected.    After the player skill level has been selected and you 
have selected "OK", just sit back and enjoy the view.    When you have seen enough, press the "Stop AutoPlay" 
button in the middle of the status bar.

When it is stopped, AutoPlayer will permit you to display the game scoreboard for the AutoPlay session, if at 
least one game was completed.    After the AutoPlayer is dismissed, Gin Rummy returns to the previous 
player's game.



 Next panel: Restart Round
Change Players
Select this menu option to switch to another player, to add a new player, or to remove a player.

· Switch:    Select the incoming player name, and press the "Switch" button.    You may select any named 
player except yourself (the current player).    When switching players, you will first be asked if the 
scoreboard for the outgoing player is to be saved, if it has changed since it was last saved.

· Add:    When you first use Gin Rummy, the only player is "Default".    Use the "Add" button to add more 
players.    When you select the "Add" button, a sub-window will appear, into which you will enter the name
for the new player.    Press "OK" to create a scoreboard for the new player.    Enter players' names as 1-8 
letters and numbers.    Spaces, punctuation marks, and special characters are not permitted.    Irrespective
of how you specify upper and lower case, Gin Rummy will always display the player names in lower case 
with the first letter capitalized.    You may have up to 12 named players at any time

· Remove:    Select the player name to be removed, and press the "Remove" button.    You may select any 
named player except yourself (the current player).        You will be asked to confirm that the player is to be 
removed, after which the scoreboard file and the saved options for the player will be permanently deleted 
from your system.



 Next panel: Redeal Game
Restart Round
Select this menu option to to restart the current round.    Gin Rummy will abandon the current round and 
restart it from the beginning, without shuffling the cards.



 Next panel: Reset Scoreboard
Redeal Game
Select this menu option to start a new game. Gin Rummy will abandon the current game, reset all counters 
and scores, and shuffle the cards before dealing.

This action restarts only the current game.    Thus, if you are currently on game 3, the play will restart at round 
1 of game 3. 

If you want to start over from the beginning of game 1, select "Reset Scoreboard".



 Next panel: Save Scoreboard
Reset Scoreboard
Select this menu option to reset your game scoreboard to zero.    The game counter will return to game 
number 1.

If you are partway through a game, the scores of the previous rounds of the game are not cleared.    Thus you 
can make the current game the first of your new scoreboard.

The previously saved copy of your scoreboard is not erased by this action.    You must use the "Save 
Scoreboard" option to replace the previous scoreboard with the new one.

If you clear the scoreboard and decide you would have preferred not to have done so, exit Gin Rummy (or 
change players) and respond "No" when asked if the updated scoreboard is to be saved.



 Next panel: Exit
Save Scoreboard
Select this menu option to perform an immediate save of the current scoreboard status (games and rounds) 
for the current player.    

This option is useful if you are enjoying an extended session of Gin Rummy and don't want to wait until you 
exit Gin Rummy, or change players, before your updated scoreboard status is safely saved to disk.



 Cycle back to: Game Menu
Exit
Terminates the session and exits from Gin Rummy.    

Before exiting, Gin Rummy asks if you want to save the updated scoreboard for the current player, if it has 
changed since it was last saved. 
 
If you respond "Yes", Gin Rummy will save the scores of all previous games and the scores of the rounds of the 
current game (if not yet completed) for the current player.    When this player next plays Gin Rummy, this 
information will be restored automatically and play will proceed with the same game number and round 
number.

If you respond "No", the scoreboard information will not be updated and when the current player next plays 
Gin Rummy, the situation will be as it was previously.

If, when you next play Gin Rummy, you start part way through an unfinished game (e.g.,    round four) and you 
wish to restart from round one of the game, use the "Redeal Game" option.

Note that Gin Rummy only saves the scores of games and rounds completed.    It does not save the card 
distribution if you exit Gin Rummy partway through a round.



 Cycle back to: Contents
Miscellaneous Information
The following topics are included to help you learn more about Gin Rummy, and enhance your enjoyment of 
the game:

About The Opponent
Skill Levels
How To...
Saved Information
Strategies
Increasing Performance
Troubleshooting
Technical Construction
Third Party Components



 Next panel: Skill Levels
About The Opponent
The opponent plays automatically after you have discarded, or when it is the opponent's turn to start a round.

The opponent skill level may be set at any of six levels from the "Skill Level" option under the "Opponent" 
menu.

 When the opponent takes a new card from the stock, it will briefly highlight the stock as confirmation.    When 
the opponent takes cards from the discard pile, it will briefly highlight the leftmost of the cards taken.    If this is
not the last discard, the opponent will also briefly highlight the card when it melds it so that you can be sure 
that the opponent is abiding by the rules. 

The opponent also pauses briefly (about two fifths of a second) after taking a card and between each of 
multiple melds so that the actions of its turn can be clearly viewed.

 If desired, the highlighting features and the pause can be turned off via the "Opponent" tab of the "Edit - 
Preferences" menu option.



 Next panel: How To...
Skill Levels
Six skill levels are available, in ascending order of difficulty from Carefree to Master.    The three higher levels 
are the most time consuming of the skill levels, and may be frustrating on a slow processor.    However, they 
make for the most challenging game and are relatively hard to beat.

When rounds and games are recorded on the scoreboard, the skill level of the opponent is also saved.    If the 
opponent skill level is changed during a round or game, then the skill level recorded is the highest that was 
used during the round or game.

Relative Performances
The scores from 100 game test series for each combination of skill levels are shown below.    These results 
should be taken as an approximate guide only.

· Standard vs. Novice:      68 - 32      (67% more points)
· Expert vs. Standard:        60 - 40      (33% more points)
· Champion vs. Expert:      58 - 42      (14% more points)
· Master vs. Champion:    55 - 45      (18% more points)

Carefree never wins because it never melds.    It is therefore not included in the above.



 Next panel: Saved Information
How To ...
How to save personal preferences
All options changed via the "Edit - Preferences" menu option are saved when the "Save Preferences" option at 
the bottom of the Preferences window is checked.

How to recover a reset scoreboard
Scoreboards are only permanently saved when you select "Save Scoreboard", or when you    respond "Yes" 
when exiting Gin Rummy or changing players.    If you have reset your scoreboard and would have preferred no
to have done so, just exit Gin Rummy    and respond "No" to the prompt "Save updated scoreboard...?"    When 
you restart Gin Rummy, your previous scoreboard will be active.



 Next panel: Strategies
Saved Information
Information is saved between Gin Rummy sessions in the Registry (32-bit version) or GINRUMMY.INI (16-bit 
version) as follows:

Registration
If you are a registered user, your name and encoded registration are stored.

AutoResume
When AutoResume is active, the name of the last player is maintained.    Thus AutoResume always recovers 
the state that it was when the previous session exited.

Personal Options
The options (configuration, player, opponent, and rules) for each player are saved.    For example, Jane's 
options will be saved in the section named "Jane".

Personal Scoreboards
Each player's scoreboard is saved in the Rummy 500 directory as xxxxxx.scb, where xxxxxx is the player's 
name.    Rummy 500 considers a player to be currently defined by whether a scoreboard file exists for the 
player, irrespective of whether options are saved for that player.    An empty scoreboard file is created for a 
player when their name is added via the "Add Player" menu option.

To clear the scoreboard completely, use the "Reset Scoreboard" option of the "Scoreboards" menu.



 Next panel: Increasing Performance
Strategies
Taking A Card
As a general rule you should consider taking the card from the discard pile only if it completes a run or a set 
with two other cards in your hand, or if it would reduce your deadwood points so that you can knock.    
Otherwise, except in rare circumstances, it is better to take a fresh card from the stock.

Discarding
Discard the card which is least useful to your hand and to the opponent.    While you can't guarantee what 
cards are useful to your opponent, remembering what they have previously discarded will give you an 
indication.    As a round progresses, consider discarding your higher points in order to reduce your deadwood 
liability should the opponent knock first.    At the beginning of a round, you might consider retaining the higher 
points in the hope that the opponent will start to discard their higher points first.

Knocking
In general, knock as soon as you can.    If you wait, there is an increased probability that the opponent might 
knock first, or undercut your knock, or be able to lay off more cards at the end of the round.    However, if it is 
early in the round, and you believe that you are close to a Gin and the opponent isn't, then you might consider
waiting.



 Next panel: Troubleshooting
Increasing Performance
Gin Rummy includes Preference options that are intensive of graphics processing.      You should select these if 
you want more realism, but deselect them if graphics performance suffers unacceptably.    These options are:

· True Corners
· Card Dragging
· "Place Card" Sound Effect.
· Animation
· Main Table Effect and Mat Effect
· Tinting of Opponent Melds
· Staggered Hand
If the speed of the deal is the only aspect that you find frustrating, consider using the "Quick Deal" or "Quiet 
Deal" under the "Deal" preferences tab.      Also, consider selecting the "Quick Display" option under the 
"Opponent" preferences tab if the opponent is too slow for your liking.    This will remove the 0.4 second delay 
between the opponent's actions.    Selecting the respective "No Highlight" options under the "Opponent" tab 
will inhibit discard and stock highlighting and the associated 0.2 second delay.



 Next panel: Technical Construction
Troubleshooting
Most problems encountered are a result of one of the following:

· Graphics driver conflict, usually manifested by the display of blank white cards.    Check that you have the 
latest drivers from your graphics card manufacturer.    Otherwise configure your system to use a graphics 
setting with fewer colors (256 or 16), or disable Table Effect and Mat Effect, and perhaps Custom 
Cardback, if you have these selected..

· Sound processing conflict.    If your system freezes when sound effects and/or speech is enabled, try 
setting "No Sound Synchronization" under the "Sound" preferences tab.    Note also that some sound cards
may exhibit problems when attempting to play music and sounds/speech together.

· Corrupt scoreboard file.    Under the "Change Players" option of the "Game" menu, remove the player for 
whom the problem occurs and re-add.    Alternatively, exit Gin Rummy and delete the corresponding 
xxxxxx.grs file from the directory where Gin Rummy resides and then re-add the player from within Gin 
Rummy.

If all else fails, delete the directory where Gin Rummy resides, and reinstall.



 Next panel: Third Party Components
Technical Construction
Gin Rummy is programmed in Microsoft Visual Basic, Version 4.

Gin Rummy works from a bitmap of all the card images and makes extensive use of the Windows API BitBlt 
function.    Because of this, Gin Rummy is fast, but consumes some RAM and GDI resources.    Alternative 
methods of managing the user interface proved to be more processor intensive and less conducive to fluid 
play.    The trade-off was made for performance at the cost of resource consumption.    

Gin Rummy is developed on a Pentium 60 with 48 MB of RAM.    Testing is performed both on this system under
Windows 95, and (for the 16-bit version) on a 486-33 class system with 8MB of RAM under Windows 3.1.



 Cycle back to: Miscellaneous Information
Third Party Components
Although Gin Rummy does not use a dll for card drawing (for performance reasons), Stephen Murphy's 
excellent freeware "qcard.dll" was used to create the bitmaps which Gin Rummy uses.    The card back designs 
included in qcard.dll were created by Daniel Di Bacco.    Acknowledgments are extended to each of them. 

The Gin Rummy help system was created using Firas Bushnaq's powerful "Visual Help".    

Visual Help is a shareware product licensed by the author.

The "Speak-To-Me" feature uses PC WholeWare's WinSpeech technology, which has been licensed by 
MeggieSoft Games for use with Gin Rummy.



 Cycle back to: Contents
About MeggieSoft Games
MeggieSoft Games is committed to the development of quality two-handed card games for the Microsoft 
Windows environment.    We currently offer three games: Rummy 500 (first released in 1994), Gin Rummy 
(1995), and Pinochle (1996).

Select a topic:

Rummy 500
Pinochle

For latest versions, news, etc., visit us on the Internet's Worldwide Web at: http://members.aol.com/meggiesoft



 Next panel: Pinochle
Rummy 500
Whereas Gin Rummy is oriented towards who knocks first and who has the lesser amount of deadwood, 
Rummy 500 is oriented towards building the highest possible score from creating melds.

A round of Rummy 500 starts with each player being dealt thirteen cards.    As the round progresses, each 
player picks up and discards similarly to Gin Rummy, with the following differences:

· Any number of cards from the discard pile may be taken, provided the earliest discarded of them is 
melded immediately.    The remainder are added to the player's hand.

· Players may lay down melds, or add to each other's melds, at any time that it is their turn.    Melding 
scores points and reduces the liability of points in a player's hand, but gives the opponent a greater 
chance of scoring points from melding some of their cards.

· A round ends when one of the players has melded or discarded their last card, or when the stock is 
exhausted.    There is no lay-off of deadwood; what the other player holds when the round ends counts 
against them.

· The first player to score 500 points wins the game.
Rummy 500 uses the same basic Graphical User Interface (GUI) as MeggieSoft Games' Gin Rummy and 
Pinochle.    Thus the display and the use of the mouse is similar in all three games.
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Pinochle
Pinochle combines elements of the Rummy and Whist families of games.    Each round is comprised of two 
phases.    During the first phase, players accumulate points from melding sets of cards in their hands.    During 
the second phase points are earned by taking tricks.

As the first phase of a round progresses, each player picks up and plays cards (similar to discarding in Gin 
Rummy or Rummy 500), with the following differences:

· The cards are played as tricks.    The higher card of each trick wins the trick.    Players may lay down a 
meld only after winning a trick.

· Melded cards remain part of the player's hand, and may be further melded (subject to certain restrictions)
or played just as other cards in the players hand.

· After each trick (and meld if there is one), each player takes a card from the stock.    The next trick is then 
played.

· When the stock is depleted, the round moves into the second phase.
During the second phase, the remaining cards are played out as tricks with requirements to follow suit and 
trump when possible.






